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Cui îi este destinata? 
 
Aceasta brosura este destinata tuturor celor care ajuta adulti sa opteze pentru diverse 
variante de formare sau angajare si care nu au utilizat, pîna acum, Internetul în acest scop. 
Daca nu ati avut niciodata timp, ati amânat sau n-ati îndraznit sa începeti sa utilizati 
Internetul, aceasta brosura este pentru dumneavoastra. Ea mai poate oferi unele idei noi si 
altora care au mai multa experienta cu utilizarea Internetului în acest context. 
 
Sumar 
  
Puteti începe cu oricare din pagini sau puteti parcurege brosura de la început pâna la 
sfârsit. 
 
• De ce sa folosim Internetul în domeniul orientarii, la urma urmei?  
• Cum încep? 
• Care sunt nevoile beneficiarilor? 
• Ce este disponibil? Care sunt resursele relevante pe Internet? 
• Cum corelam resursele cu nevoile? 
• De câta sustinere au nevoie beneficiarii? În ce masura poti ajuta? 
• Matricea Resurselor 
• Utilizarea Matricii Resurselor 
• Ajuta-te singur 
• Alte referinte 
 
 
 
 
 
Copii suplimentare sunt disponibile la http://www.guidanceforum.net 
 
Nota 
Aceasta brosura a fost elaborata într-un proiect european Socrates/Grundtvig II, sustinut 
de catre Consiliul Britanic. Cu toate acestea, opiniile exprimate sunt ale autorului si nu, în 
mod necesar, si ale Consiliului Britanic. Autorul ar dori sa multumeasca celorlati 
parteneri în proiect, enumerati pe site-ul proiectului, la http://www.guidanceforum.net, 
pentru discutiile stimulatoare si experientele împartasite. Multumiri, de asemenea, sotiei 
mele.  



De ce sa folosim Internetul în domeniul orientarii, la urma urmei? 
 
 
Învatamânt deschis si la distanta 
Poti oferi resurse privind dezvoltarea carierei mai multor oameni, în locul si la ora pe care 
o prefera, 24 de ore pe zi si 7 zile pe saptamâna, cu conditia ca persoana pe care o 
consiliezi sa aiba acces la Internet. Calitatea depinde, ca întotdeauna atunci când e vorba 
de învatamânt la distanta, de modul în care structurati si sustineti aceasta experienta. 
 
Mai multi beneficiari  
Asa cum spuneam mai sus, în functie de publicul tinta, vei putea avea contact cu mai 
multe persoane decât înainte, inclusiv cu unele pe care nu le-ati fi putut contacta în 
absenta Internetului, din cauza distantei, a mobilitatii beneficiarului sau, pur si simplu, 
din cauza nepotrivirii orelor voastre de program. Poti tine, de asemenea, legatura cu 
colegi, alti practicieni, mai simplu decât înainte.  
 
Acces la calitate 
Poti avea acces la resurse de calitate, de oriunde din lume, oricând, cu conditia sa fii 
conectat la Internet. Nu trebuie sa faci rabat la calitate doar din cauza locatiei în care te 
afli. Asigura-te, însa, ca poti sa recunosti resursele de calitate.    
 
Ridicati-va nivelul 
Daca ai abilitatile interpersonale, dar nu si cunostintele specializate pentru a îndruma pe 
cineva sîn alegerea unei optiuni de formare sau angajare, utilizarea unui web site sau a 
unei trimiteri catre o astfel de cunostinta specializata poate suplini asistenta pentru care, 
în absenta unor astfel de resurse, ai fi fost nevoit sa îl trimiti pe beneficiarul tau la un alt 
consilier. Stii mai multe. 
 
Ridicati-le nivelul 
La fel si beneficiarii tai – te vei vedea confruntat cu ‘pacientul expert’. Va trebui sa-ti 
îmbunatatesti cunostintele si sa-ti dezvolti abilitatile. Atunci când oamenii vor veni la 
tine, dupa ce au consultat deja materiale pe Internet (de exemplu, site-ul organizatiei 
tale), acestia vor pune întrebari mult mai precise si directe.  
 
Resurse gratuite 
Multe din resursele disponibile online sunt gratuite. Chiar daca trebuie sa platesti ca sa 
capeti acces la ele cu ajutorul unei parole, pretul este, oricum, mai mic, deoarece el nu 
include costuri de împachetare si de expediere prin posta. Costurile de comunicare sunt, 
de asemenea, mai mici.  
 
Acces direct 
Când informatia este disponibila online, ea poate fi actualizata mult mai simplu si regulat 
decât cea aflata pe CD, ca sa nu mai vorbim de cea tiparita. Accesul la baze de date este 
direct – si la fel este accesul la persoane cu care nu ai fi putut vorbi în absenta e-mail-ului 
sau a altor tehnologii specifice Internetului. 
 



 
Cum încep? 
 
Trebuie sa faci patru lucruri: 
 
1. Identifica grupul de beneficiari – cine sunt ei si cine ar trebuie sa fie? (Cel mai 

adesea, raspunsul la cele doua întrebari nu este acelasi!) 
2. Identifica-le nevoile  – ce anume, din experienta ta, solicita ei cel mai frecvent si 

despre ce anume au nevoie, dar nu întreaba? Poti structura aceste nevoi si întrebari? 
3. Identifica resursele disponibile – ce anume din ceea ce utilizezi în mod curent vine 

în întâmpinarea acestor nevoi? Exista carente de informatie? Pot acestea fi suplinite 
de resurse online – site-uri, servicii de pus întrebari prin e-mail, forumuri online etc.? 
Exista pe Internet resurse care ti-ar permite sa satisfaci nevoi pe care nu le puteai 
satisface înainte? Ce se întâmpla, de fapt, pe Internet? Cum utilizeaza altii Internetul? 

4. Asociaza nevoile unor resurse disponibile online pentru cei pe care doresti sa-i 
ajuti. Furnizarea pasiva a resurselor nu e suficienta : trebuie sa te gândesti cum sa 
facilitezi accesul oamenilor la resursele si serviciile care vin în întâmpinarea nevoilor 
lor, fara sa-i sufoci cu resurse si servicii de care acestia nu au nevoie. Pe Internet, de 
exemplu, realizarea acestei selectii nu este chiar atât de usor de facut.     

 
 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Care sunt nevoile beneficiarilor? 
 
Oamenii au nevoie de 
• ajutor cu privire la anumite probleme specifice – care sunt cele mai frecvente 

probleme de acest tip, din experienta ta? 
• raspunsuri la întrebari – care sunt cele mai frecvente întrebari? Colegii tai sunt de 

aceeasi parere? 
• timp pentru întrevederi  
• informatii –  
• abilitati –  
• sfaturi – 
 
Doar tu si clientii tai puteti raspunde la aceste întrebari – deoarece numai tu îti 
cunosti clientii si, deci, îi poti întreba direct. Fiecare grup de clienti poate avea nevoi 
diferite. 
 
Structureaza raspunsurile sistematic. Pot fi ele încadrate în grupe sau paradigme? 
Cum se relationeaza acestea? Le poti grupa astfel încât sa rezulte niste grupe 
generice de nevoi specifice? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Ce este disponibil ? Care sunt resursele relevante pe Internet? 
 
Site-uri – mii de locatii care pot contine informatii relevante si îndrumare, de exemplu: 

• servicii locale privind cariera, precum si în cadrul universitatilor si colegiilor, angajatori, agentii 
de plasament, colegii si universitati, sindicate, organizatii de voluntari, birouri de consiliere a 
cetatenilor, edituri, producatori de aplicatii IT privind cariera, departamente si organisme 
guvernamentale, în special DfES, Job Centre Plus, organisme profesionale, organizatii de tineret, 
biblioteci, camere de comert, institute de cercetare, alte asociatii, serviciul de probatiune, NACRO, 
MIND, EOC, CRE, NIACE, Consiliul de Orientare, s.a.m.d. 

• acestea ofera exercitii de auto-evaluare, teste, informatii cu privire la o multime de oportunitati, 
care creeaza posibilitatea de a extrage ceea ce este folositor pentru utilizator, sustinere în procesul 
decizional, instruire în cautarea locurilor de munca, îndrumare cu privire la diferitele aspecte ale 
planificarii carierei, instrumente pentru corelarea calitatilor utilizatorului cu locuri de munca si 
cursuri relevante, precum si multe altele care prezinta relevanta în domeniul orientarii, precum si 
asistenta pentru perfectionarea carierei proprii a specialistilor în orientare. 

 
E-mail – pune în legatura oricare doua persoane care au o adresa de e-mail 

• face posibila trimiterea aceluiasi mesaj catre mai multe persoane, în acelasi timp, fara a mai fi 
necesara duplicarea acestuia 

• e-grupuri, care ofera posibilitatea sustinerii unei discutii cu un grup de persoane prin e-mail, cu 
conditia ca toti acestia sa aiba o adresa de e-mail, prin care sa poata fi contactati. 

 
Forumuri de discutii 

• ofera posibilitatea de interactionare, discutii si schimb de experienta cu ceilalti fara a fi necesar  ca 
acestia sa se afle în acelasi timp si în acelasi loc cu tine 

 
Chat – „discutii” cu oricine se afla conectat la retea în acelasi timp, si care foloseste acelasi program 

• similar cu o conversatie telefonica, folosind, însa, tastatura 
 
Video conferinte – pentru comunicarea directa la distanta 

• pentru ca cineva care are putina experienta în dome niu sa poata ajuta mai multe persoane la 
distanta  - de ex. comentarea rezultatelor testarii 

• poti ajuta persoane aflate în zone departate sau care nu te pot vizita din cauza unor bariere 
culturale  

 
Posibilitati de publicare – poti publica pe Internet fara a fi expert în domeniul informaticii 

• creeaza-ti propria pagina pe Internet sau altceva similar 
• publica fara a astepta ajutorul unei edituri 

 
 
 
  
 
 
 
 
 
 
 
 
 
 



Cum corelam resursele cu nevoile? 
 
Specifica ceea ce doresti sa obtii. 
 
Cum crezi ca se vor schimba oamenii dupa ce vor folosi serviciile/resursele tale ? 
 
ICIC (DOTS) Modelul „DOTS” structureaza nevoile în întâmpinarea carora doresti sa vii (enumerate aici 
în ordine logica: ICIC). Pentru a face alegerea cea mai potrivita cu privire la formare si un loc de munca, 
oamenii trebuie sa fi obtinut: 

• Constientizare de Sine – cunoastere de sine, cunoasterea intereselor, aptitudinilor, valorilor si 
experientei 

• Constientizarea Oportunitatilor – cunoasterea oportunitatilor, de ex.: cursuri, locuri de munca 
[corelarea CS cu CO pentru a se obtine un numar suficient de oportunitati] 

• Învatarea prin decizie – a opta între unul sau mai multe elemente, în urma unei selectii prealabile 
• Învatarea prin tranzitie – implementarea deciziei, obtinerea unui loc de munca, înscrierea la un 

curs, administrarea perioadei de tranzitie ulterioare (supravegherea copiilor în timp ce urmezi 
cursul, obtinerea resurselor financiare pentru a face acest lucru, s.a.m.d.) 

  
Modelul DOTS a fost enuntat pentru prima oara de Bill Law si Tony Watts – NICEC, în 1977. 
 
FIROT (FIRST) Un set alternativ a fost creat pentru a masura posibilele efecte a unui interviu de orientare 
asupra persoanei intervievate. În ordinea initialelor, rezulta: 

• Focalizare – cunosc bine problematica si ce anume doresc sa faca ? 
• Informatie – au toate informatiile necesare ?  
• Realism – sunt realisti în ceea ce priveste (a) propria persoana si (b) piata muncii ? 
• Obiectiv – sunt mai constienti în ceea ce priveste oportunitatile dintre care pot alege ?  
• Tactici – stiu care sunt pasii urmatori si cum sa obtina ceea ce doresc ? 

 
[Ordinea „logica” ar fi, mai degraba, F/O, R, I, T] 
 
„Interviuri de orientare vocationala” Bedford, T., Departamentul de Plasament (1982) 
 
Ce set preferi? 
 
Treci în revista propriile grupe generice de nevoi specifice de la pag. 4. Se înscriu în modelele ICIT sau 
FIROT? În cazul în care acest lucru nu se întâmpla, nu este nici o problema, atâta vreme cât propriul set 
contine întrebarile, problemele si necesitatile grupului dvs. tinta. Bineînteles, acestea pot fi diferite pentru 
fiecare grup. 
 
Acum utilizeaza propriul set pentru a structura resursele de care aveti nevoie pentru a veni în 
întâmpinarea acestor nevoi – de exemplu, în cazul în care va uitati pe paginile de Internet în termeni de 
„ICIT”, va pot fi de ajutor, într-o mai mica masura, în ceea ce priveste constientizarea de sine, într-o mai 
mare masura, în ceea ce priveste constientizarea oportunitatilor, putine care ofera ajutor cu privire la 
învatarea prin decizie si multe care va pot ajuta în ceea ce priveste învatarea prin tranzitie – mai ales daca 
este vorba de tranzitie catre un (nou) loc de munca. 
 
Consulta listele de site-uri din Marea Britanie la http://www.guidanceforum.net. Aici vei vedea site-uri 
grupate dupa sistemul ICIT. Este acesta un cadru de lucru util pentru tine? Sau ai nevoie, ca punct de 
plecare, sa îti creezi o lista utilizând propria ta metoda de structurare? 
 
 
 
 
 



De câta sustinere au nevoie beneficiarii? În ce masura poti ajuta? 
 
Indivizii au nevoi, iar tu ai resurse – iar tu trebuie sa faci sa se întâlneasca nevoile si resursele. Înainte, însa, 
trebuie sa iei în considerare un anumit aspect. De câta sustinere sau ajutor au nevoie aceste persoane pentru 
a utiliza resursele oferite. 
 
Indivizii au nevoie de sustinere la trei nivele diferite: 

1. Auto-ajutorare: Unii oamenii se descurca pe cont propriu. Pot utiliza resursele necesare în acest 
sens. 

2. Ajutorul unui ne-specialist, sau de grup: Unii oameni au nevoie de putin ajutor, ca punct de 
plecare, si surse de îndrumare, în cazul în care ajung într-un punct mort – dar, în general, se pot 
descurca singuri, fara a avea nevoie de specialisti în îndrumare sau orientare. Deseori, de exemplu, 
ei pot apela la ajutorul celorlalti, în cadrul unui grup. 

3. Ajutor direct, specializat: Unii oameni au nevoie de foarte mult sprijin. Au dificultati majore, 
sunt indecisi, nu numai nehotarâti, sau, în plus, au de depasit obstacole sociale, culturale sau 
economice. Pot avea nevoie de ajutor specializat pentru a utiliza resursele care vin în întâmpinarea 
nevoilor. Pot avea nevoie, de asemenea, de ajutor direct. 

 
Resursele se împart, de asemenea, în trei largi categorii: 

1. Resurse care nu necesita ajutor pentru utilizare – multe pagini pe Internet sunt concepute în 
acest fel, putând fi utilizate fara un alt ajutor. La fel sunt concepute si unele aplicatii informatice si 
multe carti, casete video sau audio, etc. 

2. Resurse care necesita ajutor într-o mica masura pentru utilizare. Unele resurse sunt mai 
complexe sau mai interactive, sis teme computerizate – pot fi utilizate pe cont propriu, însa, aceasta 
experienta ar fi mult îmbogatita si mult mai folositoare daca ar fi împartasita cu ceilalti sau daca s-
ar apela, într-o mica masura, la ajutor cu privire la modul lor de utilizare. Aceasta se aplica si 
experientei de munca si unor cursuri. 

3. Resurse care necesita ajutor specializat pentru a fi utilizate eficient. Un bun exemplu sunt 
testele psihometrice de aptitudini – etica testarii presupune ca testul sa fie disponibil numai daca 
exista siguranta ca este prezent un specialist care sa fie în masura sa asigure o interpretare a 
rezultatului. De asemenea, unele surse de informatii asupra pietei de munca necesita sprijin 
specializat pentru a fi explicate. Aceste resurse trebuie utilizate, în general, în contextul 
contactului direct, cum ar fi interviul de orientare, acesta fiind, în sine, o resursa specializata. 

 
Ce nivele de sustinere oferi? 
Indivizii si resursele se afla, deci, pe nivele diferite: este posibil ca organizatia ta sa nu poata oferi toate 
aceste trei nivele de servicii – auto-ajutorare, nespecializat, specializat/profesional. Poti oferi toate aceste 
trei nivele de servicii pentru unele grupe de nevoi (de exemplu, constientizarea oportunitatilor), dar nu si 
pentru altele (de exemplu, proces decizional sau constientizare de sine). Poti oferi numai sesiuni de grup 
sau sa nu ai personal instruit în orientare. Este posibil sa nu îti poti permite resurse pentru specialisti.  
 
 
 
 
 
 
 
 
 
 
 
 
 



Matricea Resurselor 
 
Aceasta ofera un mod reprezentativ de a analiza relatia dintre resurse, nevoi si nivele de servicii/sustinere. 
Ce nevoi doresti sa satisfaci în cadrul organizatiei tale si de ce tip de resurse ai nevoie pentru aceasta? Ai 
nevoie de mai mult de o matrice – una pentru fiecare grup tinta? O resursa poate fi folositoare pentru un 
grup tinta la nivelul sustinerii proprii, dar nu poate fi utilizata, fara asistenta, de un alt grup, iar indivizii din 
cadrul aceluiasi grup tinta pot fi diferiti din punct de vedere al nivelului de sustinere de care au nevoie. 
Trebuie sa ai în vedere ca aceasta este o reprezentare bi-dimensionala a unei realitati multi-dimensionale. 
Scopul ei este de a-ti stimula gândirea – nu ofera raspunsuri la toate întrebarile la care va trebui sa faci fata. 
 
Sunt toate rubricile completate? Cu ce? 
 
Poti completa fiecare rubrica cu o resursa din cadrul organizatiei sau dintr-o alta sursa pentru a veni în 
întâmpinarea nevoilor definite de aceasta? [De exemplu, carti, materiale video, brosuri, plasamente, cursuri, 
aplicatii informatice, e-mail, site-uri sau pagini pe Internet, sesiuni de grup, discutii directe etc.] Ai rubrici 
completate cu resurse în dublu exemplar? Ai multe rubrici completate cu resurse limitate sau costisitoare, 
cum ar fi consilierea directa sau interviul? Ai rubrici necompletate? De ce? Pot exista argumente suficiente 
(de exemplu, nu acest tip de servicii oferim clientilor nostri) sau este posibil sa fi scapat din vedere 
problema vizata. Este nevoie de combinarea resurselor pentru a corela necesitatile cu respectivul nivel de 
sustinere? Unele rubrici vor trebui completate cu mai multe resurse pentru a veni în întâmpinarea 
necesitatilor definite de acestea. Pe de alta parte, mai multe rubrici pot fi completate cu o resursa complexa, 
pe mai multe nivele si pe mai multe coloane.  
 
Rezultate si 
nevoi > 
 
Utilizatori/  
Sustinere 

Constientizare 
de sine 
 
 
1 

Constientizarea 
oportunitatilor 
 
 
2 

Corelare  
1&2 
 
 
3 

Învatare prin 
decizie 
 
 
4 

Învatare prin 
tranzitie 
 
 
5 

Nivel 1 
 
 
Auto-ajutorare 

     

Nivel 2 
Sustinere 
nespecializata 
sau de grup 

     

Nivel 3 
 
Sustinere 
Specializata 
 
Dialog direct 

     

 
 
 
 
 
 
 
 
 
 
 



Utilizarea Matricii Resurselor 
 
1. Familiarizeaza-te cât mai mult cu utilizarea resurselor virtuale sau cu alte resurse de pe Internet. 
În cazul în care nu ai timp pentru tot ce îti propui, poti împarti restul sarcinilor cu colegii? Începe cu cele 
mai adecvate site-uri de tip Gateway – vezi lista de site-uri britanice la 
http://www.guidanceforum.net pentru sugestii sau viziteaza  
http://www.careers-portal.co.uk/netguide/M4WWW.htm  
 
Daca si altii s-au aflat în aceeasi situatie, de ce nu ai învata din experienta si cercetarile acestora? Vei vizita 
unele site-uri mai mult decât altele, iar în curând aceste cai îti vor deveni mai clare. Vei începe, ulterior, sa 
investighezi pe cont propriu. În domeniul orientarii adultilor, site-ul Support4Learning, în special, este un 
bun punct de plecare. 
http://www.support4learning.org.uk 
 
2. Grupeaza site-urile folositoare pe care le gasesti, în functie de structura pentru care ai optat, având 
în vedere modul în care acestea vin în întâmpinarea nevoilor clientilor. Poti folosi matricea resurselor, 
pentru a include adresele site-urilor în rubricile corespunzatoare. Nu ai resurse suficiente pentru a acoperi 
fiecare rubrica pe care doresti sa o completezi cu resurse virtuale? În acest caz, poti sa te gândesti la câteva 
cuvinte-cheie care ar putea sa descrie ce anume cauti si pe care le vei folosi cu ajutorul unui motor de 
cautare pentru a gasi mai multe materiale? (de exemplu, http://www.google.co.uk). 
 
3. Noteaza-ti fiecare site în functie de cât ajutor ai dori sa oferi utilizatorului  – nivelele 1/2/3. Aceasta 
te va ajuta sa determini la ce rubrica se va afla site-ul. 
 
4. Compara site -urile si alte resurse virtuale cu resursele si serviciile pe care le utilizezi deja pentru a 
acoperi aceste nevoi (inclusiv chestiuni cum ar fi interviuri directe, sesiuni de grup, experienta de munca, 
cursuri, precum si carti, materiale video, brosuri etc.). Aceste resurse si servicii  

• acopera nevoi înca neacoperite de alte resurse? 
• vin în întâmpinarea acestor nevoi, mai eficient, mai usor sau mai putin costisitor?  
• acopera nevoile grupurilor pe care nu le-ai fi putut ajuta prin alte metode, în nici un caz utilizând 

resurse traditionale? 
 
5. Ce alte resurse poti adauga în afara de cele virtuale? Poti oferi informatii sau îndrumare celor pe care 
doresti sa-i sprijini, cu ajutorul postei electronice? Poti sa-i pui în legatura, în scopul schimbului de 
informatii, cu ajutorul unui site sau a unui e-grup? 
 
Pentru mai multe sugestii pentru utilizarea si administrarea postei electronice sau a altor resurse similare 
vezi: 
Developing Adult Guidance Skills: Working with Guidance Technology 
National Extension College, (2002) ISBN 1 84308 061 3 
http://www.nec.ac.uk/resources/product?product_id=198&category_id=463 
 
6. Implica-i si pe utilizatorii finali  – ce gasesc acestia ca fiind mai util?  
 
 
 
 
 
 
 
 
 
 
 
 



Ajuta-te singur 
 
Nu ai nevoie de foarte multe cunostinte si aptitudini tehnice pentru a crea instrumente si resurse utile cu 
ajutorul Internetului. Iata câteva idei care ti-ar putea fi de ajutor. 
 
WWW 
Creaza-ti o lista de site-uri pe care doresti sa le utilizezi, pentru fiecare grup de clienti cu care lucrezi, cu 
ajutorul comenzilor favorites  sau bookmarks. 

• Poate deveni aceasta o resursa în sine  - sau online pentru a fi accesata de clienti – poate prima 
pagina de Internet care se deschide, în momentul conectarii – un punct de plecare pentru 
raspunsuri la tipuri specifice de întrebari cu privire la teme specifice sau grupuri specifice de 
utilizatori? [În cazul în care utilizati Explorer pentru a naviga pe Internet foloseste comenzile 
Tools>Internet Options>General, pentru a face ca orice pagina Internet, a carei adresa o tastati, sa 
se deschida imediat ce pornesti browser-ul.] 

• Este utila, de asemenea, ca brosura tiparita, pentru a fi oferita clientilor?  
• Ai putea pune lista pe o discheta pentru a putea fi luata? Nu uita ca în Word, precum si în multe 

alte programe de editare, poti transforma o adresa de Internet într-un hyperlink (de exemplu, 
utilizatorul poate apasa, cu ajutorul mouse-ului, pe adresa, pentru a i se deschide pagina de 
Internet respectiva, în cazul în care este conectat la Internet în momentul lecturii sau îsi poate 
porni browser-ul, în cazul în care nu este conectat la retea). Se poate efectua aceeasi operatiune si 
în programul PowerPoint (selecteaza Insert>Hyperlink pentru a vedea optiunea). Un fisier de tip 
Word sau slide-uri de tip PowerPoint devin astfel cai simple de utilizare eficienta a Internetului, 
pentru orice individ sau grup de utilizatori, în domenii cum ar fi, de exemplu: cautarea de locuri de 
munca, auto-evaluare sau întelegerea optiunilor locale , ori pentru a raspunde celor mai frecvente 
zece întrebari pe care le pun acestia. 

• Poate fi acesta un mod de orientare pentru colegi sau alti profesionisti cu care lucrezi? Sau poate fi 
de ajutor pentru persoane (poate din alte organizatii) din acelasi domeniu, dar care nu au aceasta 
pregatire si au nevoie de calificarea ta  Poate deveni, de asemeni, un instrument de instruire – 
instruire pentru utilizarea Internetului în domeniul orientarii în cazuri specifice, precum si în 
general – în functie de situatia în care te afli. 

• Poti sa-l transformi într-un exercitiu pentru utilizator – pagina cu pagina, în progresie logica, cu un 
text aferent scris de tine? Poti folosi programul Word sau PowerPoint sau alte programe similare, 
pentru a face acest lucru suficient de usor, dupa cum am mentionat mai sus. În cazul utilizatorilor 
tineri, poti transforma aceasta metoda într-o “cautare de comori” sau într-un tur cu ghid… În cazul 
în care ai nevoie de idei, poti vizita http://www.kn.pacbell.com/wired/fil, un site pentru profesori 
(pedagogi) care ofera câteva îndrumari în cazul în care ai nevoie de ajutor si care îti permite sa 
creezi o pagina de Internet fara a avea nici un fel de aptitudini. 

 
În cazul în care asimilezi mai multe cunostinte, poti dori sa-ti creezi propria pagina pe Internet. Exista  
multe tutoriale pe Internet care îti pot fi de folos în acest scop. Încearca http://www.blogger.com, daca 
doresti un mod simplu de a-ti publica ideile pe Internet, chiar daca ai mai facut sau nu acest lucru pâna 
acum. 
 
Email  
 

• Bineînteles, poti oferi îndrumare si informatii cu ajutorul postei electronice, daca beneficiarii au o 
adresa de email. Obtinerea unei astfel de adrese este facila, cu conditia sa existe acces la Internet: 
este o aptitudine utila pentru adulti si, oricum, poti obtine doua lucruri dintr-o data – prezinta si 
altora procedura postei electronice si încurajeaza-i sa o utilizeze pentru a se informa si a fi 
îndrumati. 

• Poti adauga câteva nume , într-o lista, în agenda programului de e-mail – vezi paginile de ajutor din 
sistemul pe care îl folosesti, pentru a sti cum sa procedezi – aceasta consta, de obicei, în tastarea 
adrese de e-mail, separate prin virgule. Apoi poti trimite mesaje prin posta electronica catre toti cei 
din lista printr-o singura comanda. Prin accesarea comenzii reply to all poti raspunde la mesajele 
tuturor celor de pe acea lista printr-o singura comanda, sau ei pot raspunde mesajelor tale. Poti 



derula astfel online un e-grup de cautare de locuri de munca sau sa oferi asistenta într-un curs sau 
plasament. În cazul în care acestia au aceeasi lista de adrese ca si tine, pot folosi, de asemenea, 
aceasta lista pentru a comunica între ei si pentru a se sustine. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Alte referinte 
 
Învata din faptele si experienta altora – viziteaza pagina Ancheta, la Guidanceforum.net 
http://www.guidanceforum.net/survey.htm 
 
• Vei vedea contributiile altor profesionisti din toata Europa, în domeniul orientarii. Adauga-o si pe a ta ! 
• Te poti, de asemenea, abona la lista de pe prima pagina a site-ului Guidanceforum.net – tasteaza-ti 

adresa de e-mail si aboneaza -te la e-grupul Yahoo.  [Poti crea o categorie similara pe site-ul Yahoo 
pentru clientii tai – nu este dificil – iar acesta ar fi primul pas de facut, dupa lista pe care am mentionat-
o la pagina anterioara].  



 
• Lista de site-uri britanice de pe Guidanceforum.net a fost deja mentionata. Poti gasi aici mult mai 

multe puncte de plecare utile, precum si pe alte liste oferite de ceilalti parteneri europeni implicati în 
acest proiect. 

• Mai exista si alte câteva resurse – carti si site-uri – care te-ar putea ajuta. Acestea pot fi trecute pe lista 
de la Guidanceforum.net dar, în special, îti pot fi utile urmatoarele: 

 
Ghidul Internet pentru profesionistii în domeniul carierei, Offer, M.S., Editura Trotman, (2000) ISBN 
0 85660 582 4. Aceasta publicatie este utila atât pentru începatori, cât si pentru cei cu cunostinte tehnice 
avansate în acest domeniu. Este conceputa în stilul programelor de învatare la distanta. Se poate fotocopia 
si contine studii de caz, exercitii si un set de trimiteri catre site-urile pe care le puteti gasi la 
http://www.careers-portal.co.uk/netguide. Le vei întelege mai bine daca vei cumpara si cartea. Pentru mai 
multe detalii consultati catalogul Trotman la http://www.careers-
portal.co.uk/professional/resources/?m=netguide.htm  
 
Tehnologia în domeniul orientarii – o parte dintr-un program mai dezvoltat de învatare la distanta numit 
Dezvoltarea Aptitudinilor de Orientare pentru Adulti, National Extension College (2001), ISBN 1 84308 
061 3.  
Vezi http://www.nec.ac.ik/resources/product?product_id=1898category_id=463  
Contine sectiuni cu privire la utilizarea postei electronice, evaluare si standarde de calitate precum si cu 
privire la integrarea TIC în domeniul orientarii, în general. Contine si o licenta de fotocopiere. 
 
Centrul pentru Studiul Tehnologiei în Domeniul Consilierii si al Perfectionarii în Cariera 
Acest site contine câteva materiale interesante cu privire la utilizarea Internet-ului în domeniul îndrumarii. 
Câteva dintre ideile din aceasta brosura apartin profesorului Jim Sampson care profeseaza în cadrul 
Centrului, la Universitatea Statului Florida. http://www.careers.fsu.edu/techcenter/  
 
Legatura dintre Cariera si TIC. Brosura si site. În principal referitor la utilizarea TIC în educatia privind 
cariera în cadrul scolilor, dar unele dintre aceste informatii pot fi utile si referitor la adulti. Asociatia 
Britanica pentru Comunicare Educationala Tehnologie (CEMBAT) (2001), DfES/Connections Service 
National Unit. Site-ul se afla la adresa http://www.becta.org.uk/careersict. 
 

Puteti contacta de asemenea pe autorul acestei brosuri prin posta electronica la adresa 
marcusoffer@postmaster.co.uk 

 

 
 
 
 
 


